This paper is a series of lesson plans designed to assist teachers with the instruction of the exceptional learner. The focus is on identifying what the exceptional learner needs, and provides specific lesson plans that meet those needs. Exceptional learners experience difficulty with spelling, organization, and metacognition. Detailed directions on how to use Microsoft Word are provided. The 11 lessons included are: (1) "How to Set Up a Macro on Microsoft Word"; (2) "Directions for Using Auto Text Entry"; (3) "How to Set Up a Table of Contents"; (4) "How to Update a Table of Contents"; (5) "Directions for Using Word Art"; (6) "Directions for Sorting Lists"; (7) "Directions for Setting Up a Frame"; (8) "Making Text Boxes Overlap"; (9) "Instructions for Setting Up Hypertext Links"; (10) "Directions for Customizing the Toolbar"; and (11) "Directions for Using Mail Merge." (DLS)
Technology Applications for the Exceptional Learner

By:

Janet Burke

Presented at the National Catholic Educational Association
95th Annual Convention & Exposition (April 14-17, 1998)
This paper is a series of lesson plans designed to assist teachers with the instruction of the exceptional learner. The focus is on identifying what the exceptional learner needs, and provides specific lesson plans that meet those needs. Exceptional learners experience difficulty with spelling, organization, and metacognition. Detailed directions on how to use Microsoft Word are provided. Microsoft Word can help solve everyday instructional obstacles. This paper should be used as a detailed handbook for beginning and veteran teachers.
Objective: Put a heading on a student’s paper by striking only two keys.

A Macro is a series of operations, which are then assigned to keys that do all the work for you.

Example:

Janet Burke February 7, 1998
Mathematics Ms. Mary Smith (Teacher)

Too often, teachers end up with papers without student names. This can be frustrating for teachers and students. It may help students, who are forgetful, to simply strike two keys to obtain a professional heading on all assignments. Teachers can help their students to set up headings using Macros. Macros help students to begin their papers with topics and names. This will help the student’s self esteem and reduce frustrations for the educator. The computer directions throughout this paper were obtained from Seiter, C., Engst, E. & Sosinksy, B. (1995). Microsoft Office. NY: Macmillan Computer Publishing.

How to Set Up a Macro on Microsoft Word

1. Select “Macro” from the Tools menu.

2. Click “Record New Macro.”

3. Type the name of your Macro, (Janet). Give it any name you desire.

4. In the same dialog box, at the bottom, select “All Documents” so the Macro’s heading will be available for all class assignments.

5. Type a short description in the dialog box. (Optional)

6. Word places you in the Customize Keyboard dialog box. In the dialog box, “Assign” the Macro to the “Keyboard”.

7. At the bottom, of Customize Keyboard dialog box, “Press new shortcut key.” To assign a shortcut key, for example, press “Alt-0.” To the right of the same Customize Keyboard dialog box, click assign, then click close.

8. Type the heading for each student because Word is recording all the steps you execute. Any command or typing you do is recorded. If you want the student to open a new file, then record the heading, or you may decide this Macro will print a full page of directions geared specifically for the needs of a student(s).

9. Click “Stop recording.” Now type the shortcut key you assigned. In this case, “Alt-0,” will type the student’s heading and/or anything else you recorded.
Directions for Using Auto Text Entry

Auto Text Entry will provide predictive spelling for students.

Example: A History or English Text with Constitution of the United States.

The student types "Cons" then the computer will automatically print out "Constitution of the United States."

Predictive Spelling with Auto Text Entry – Why is this useful? Predictive spelling is useful for students with learning disabilities because they often have difficulty with spelling. The teacher is unable to assess the brilliance of the student because these rudimentary procedures of spelling stand in the way.

Exceptional students have a difficult time spelling multi-syllabic words. With Auto Text Entry, the teacher can anticipate the words in the lesson, which will give the student the most difficulty. If the class is studying the Constitution of the United States and an assignment is given to write a report about the Constitution, every time the student writes "Cons" the Auto Text Entry automatically displays the "Constitution of the United States" for the student. The student then presses "Return" to accept the suggestion.

DIRECTIONS FOR USING AUTO TEXT ENTRY

1. Type in whatever entry you want the Auto Text Entry to recall then highlight it.

2. From the toolbar, under "Insert," click "Auto Text." To the right of Auto Text, click "New."

3. You can accept the name generated by the computer or type at least four characters for the particular entry. In this example, "Cons." was selected Use the beginning four letters of the entry or word you want to see typed out for the student. This way your student will only have to type those four letters to receive as big an entry as you deem necessary.

Another way to apply Auto Text Entry is:

1. From the toolbar, under "Insert," click "Auto Text." To the right, click "Auto Text" again.
2. When the Auto Text screen pops up, select "Normal.doc." In this way, the student will have access to the Auto Text entry in all her assignments.

How Auto Text Entry Works.

In summary, instruct the students to type the report just as they normally would. This time when the student types the first four letters of the Auto Text Entry the longer version of the word they had difficulty with or the information you wanted inserted will automatically be typed.
How to Set up a Table of Contents

Exceptional students require a great deal of organizational skills. A table of contents can help the educator and the student better organize their work.

Table of Contents

Introduction to story---------------------------------------------------------------5
Characters-------------------------------------------------------------------------7
Setting-----------------------------------------------------------------------------8
Plot-------------------------------------------------------------------------------9
Ending-------------------------------------------------------------------------------10

1. To begin this process, the educator should highlight information they would like to have included in the table of contents. Next, select a “Style” from the style box below the toolbar. The style box should say “Normal,” change it to “Heading 1, 2...” depending on the text’s importance.

2. Now position the cursor where you want the table of contents to appear.

3. Under “Insert”, select index and tables. When the table of contents dialog box appears, click on the “Table of Contents” tab. Do not use the Index tab window that automatically opens.

4. Click the “Show page numbers” so that a check mark appears in the box.

5. Select “Right align page numbers” so that a check mark appears in the box.

6. Select the “Tab leader” you desire.

7. On the right hand of the same dialog box, click “Options.”

8. In the “Table of Contents Options” dialog box, make sure “Styles” is checked. If it does not have a check in the box, put one in there.

9. Click “OK” twice.
How to Update a Table of Contents

1. **Highlight the Table of Contents**

2. Press the key "F9."
Word Art

Directions for Using Word Art

Too often the exceptional child suffers from a lack of self-esteem. It is a small wonder when everything they attempt academically ends in failure. Word Art can help.

Word Art allows them to see their name written with flair.

Or, use Word Art to help them remember vocabulary words.

Word Art Directions

1. Under the "Insert" menu in the Toolbar, select "Object."

2. When the Drawing Toolbar Menu appears, select "Microsoft Word Picture" then click "OK."
   The Word Art pop-up screen will appear.

3. Have the student type in her name. Try different styles to show the student how to display her name.

4. Add this Word Art to the screen saver so the student is constantly reminded of their importance, or use it to display the vocabulary word of the day.
Exceptional students have difficulty with organization; therefore, "Sorting Lists" may be crucial to keeping them organized. Students have different things to do during the day/week. "Sorting Lists" may help them remember these assignments/tasks, if it is placed in alphabetical order.

Example:

**Activities**
- Science Homework
- History Homework
- English Homework
- Walk the dog
- Shower
- Art Homework
- Call Mom or Dad
- Pick up the mail
- Send clothes to tailor
- Cook dinner
- Clean the dishes
- Science Homework
- History Homework
- Pick up the mail
- Send clothes to tailor
- Cook dinner
- Clean the dishes

**Activities to Do using Sorting List**
- Art Homework
- Call Mom or Dad
- Clean the dishes
- Cook dinner
- English Homework
- History Homework
- Pick up the mail
- Send clothes to tailor
- Shower
- Walk the dog

**Directions for Sorting Lists**

1. Make a list of activities to do for each student or students.
2. Under Insert, select "Table," then select "Sort."
3. The "Sort" pop-up screen appears.
5. Click "OK."
Focus on Homework

*Directions for Setting up a Frame*

<table>
<thead>
<tr>
<th>Homework.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Math, page 78, problems 1-20.</td>
</tr>
<tr>
<td>History, page 32. Write an essay about World War II.</td>
</tr>
<tr>
<td>Science, page 45. Write the lab report on earthworms.</td>
</tr>
</tbody>
</table>

Drawing a frame around the text may help the exceptional learner focus on the task at hand like the homework assignment above. Please be careful and make sure their disability if any, is not figure-ground discrimination.

1. From the toolbar, select "View." From View, select "Page Layout View."

2. Type and highlight what you want to frame.

3. Under "Insert," select "Text Box."
Making Text Boxes Overlap

Metacognitive Skills

The exceptional learner does not have appropriate metacognitive skills. The educator must teach the student how to learn by providing the exceptional student with cues to help focus on the instructions. An assignment to read a passage from Mutiny on the Bounty may prove a difficult one for the exceptional learner. The exceptional learner does not have the study skills to stop and reflect on the meaning of the material. Instead, they hurriedly read, glossing over the material to finish the assignment. Framing inserts may help them stop and take notice of some of the key points the instructor wants them to learn or understand.

Example:

The exceptional learner does not have appropriate metacognitive skills. The teacher must teach the student how to learn by providing the exceptional learner with cues to help her focus on the instructions. For example, an assignment to read a passage from Mutiny on the Bounty may prove a difficult one for the exceptional learner. The exceptional learner does not have the study skills to stop and reflect on the meaning of the material. Instead, they hurriedly read, glossing over the material. Reflect on the word *mutiny* here. What does it mean? If you do not know the meaning, look it up in the dictionary.

Janet saw Fluffy in the tree. → Where did Janet find Fluffy?

She got a ladder from the tool shed.

Soon she took her little black kitten down.

Fluffy had a hurt paw. → Why did Janet take Fluffy inside?

Janet took Fluffy inside, and took care of him.

Soon Fluffy was well, and Janet was happy again.

Making Text Boxes Overlap

1. In the toolbar, under "View," make sure you are in the "Page Layout View."

2. Under "View," choose "Toolbars," then select the "Drawing Toolbar."
3. In the drawing toolbar, select “Text Box.”

4. Click and drag the text box on top of the selection the student is going to read.

5. The handles (square boxes on the lines of the box) around the text box allow you to shrink or enlarge the box.

6. Type out your message to the student.
Instructions for Setting up Hypertext Links

Objective: Giving exceptional students a great deal of work in small chunks.

Hypertext Links

Exceptional students are often overwhelmed when they see a great deal of print. The student(s) know they are already experiencing trouble with reading. So that when they encounter a great deal of reading, they often give up before really trying to read the work. A great deal of print to a first grader can be defined as one page of print, to a twelfth grader it could be 100 pages. Therefore, the teacher can give the lesson piecemeal. With hypertext links the educator can set up an index, and the student can click on that index in order to get the information piecemeal versus all at once. Please see the following sample lesson to understand how hypertext can work in your classroom.

<table>
<thead>
<tr>
<th>Subject</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexander the Great</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Adolf Hitler</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Aristotle</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Fidel Castro</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Cleopatra</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Confucius</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Martin Luther King</td>
<td>Double click here for information.</td>
</tr>
<tr>
<td>Pope Paul II</td>
<td>Double click here for information.</td>
</tr>
</tbody>
</table>

The student sees this portion of the text.
<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexander the Great</td>
<td>United Greek city-states and conquered Persia.</td>
</tr>
<tr>
<td>Adolf Hitler</td>
<td>Leader of Nazi party, led Germany in WWII.</td>
</tr>
<tr>
<td>Aristotle</td>
<td>Greek philosopher and logician.</td>
</tr>
<tr>
<td>Fidel Castro</td>
<td>Cuban revolutionary leader.</td>
</tr>
<tr>
<td>Cleopatra</td>
<td>Egyptian queen and ally of Julius Caesar.</td>
</tr>
<tr>
<td>Confucius</td>
<td>Philosopher on human relationships.</td>
</tr>
<tr>
<td>Martin Luther King</td>
<td>Civil rights leader.</td>
</tr>
<tr>
<td>Pope Paul II</td>
<td>The current pope and spiritual leader of the Roman Catholic Church in Rome.</td>
</tr>
</tbody>
</table>

**Instructions for Setting up Hypertext Links**

1. Highlight the information you want the student brought.
2. Under "Insert," drag the mouse to "Bookmark." In the bookmark dialog box, give the information you highlighted a name. (The name must not have spaces. It must begin with a letter and not be longer than 40 characters.)
3. Click the "Add" button in the left hand corner of the dialog box.
4. Put the cursor where you want your hypertext link("The Go To Button").
5. Go to the "Insert" menu and drag down to "Field."
7. Click the "Options" button on the right of the dialog box.
8. The "Field Options" dialog box pops up.
9. Under the Bookmark Name list, select the name of the bookmark you formerly typed in step 2.
10. Click the "Add to Field" button on the right. The name of the bookmark will show in the text.
11. After the bookmark name you originally selected, type what you want the students to see when they click on the "Go To Button".

12. The text that you write is referred to as the "Display Text," and it will be the information that the student will see.

13. Click "OK," and this will return you to the Field Dialog Box.

14. Click "OK," and this will return you to the document.

15. Double click on the display text (Double click to learn about Alexander the Great), and the student will be brought to that section.
Customizing the Toolbar for the Exceptional Student

Teachers may want to customize the toolbar for the exceptional students, for a variety of reasons. Some students will require one icon at a time in order to master the entire toolbar. Other students will depend extensively on one icon in order to get a project done. Whatever situation you find yourself in, the following directions will help you customize a toolbar to meet the needs of your students.

**Directions for Customizing the Toolbar**

1. Under “View” in the toolbar, select “Toolbars,” then choose “Customize.”
2. Under the toolbars tab, choose “Customize Dialog Box,” click “New.”
3. Give the Customize Toolbar a name for example, date. Now click “OK.”
4. An icon for the toolbar will pop-up on the screen.
5. Click and drag that icon wherever you like it to appear on the toolbar menu.
6. Next click the “Commands” tab.
7. Click “Insert” for example, under categories, under the commands tab.
8. Under commands, select “Date,” and then drag the icon from command to the newly created icon.
10. Change button image, select one. I chose the smiley face.
11. Hit the “Close key.”
Directions for Using Mail Merge

Starting the Main Document


4. Under “#1 Main Document” the mail merge helper will appear. Click the “Create Button Menu,” and drag down to select “Form Letters.” A dialog box appears, asking you which document you want to use.

5. Click the “Active Window” button, and the type of merge appears. Form Letters and the name of the main document appears beneath the create button.

Starting the Data Document

If the Data Document already exists,

1. Click the “Get Data” button and select “Open Data Source,” an open dialog box appears, where you can open the document.

2. Click the “Open button,” if data document is ready, click the “Edit Main Document” button, and continue with “Finalizing the Main Document.”

If the Data Document does not exist.

1. Click “Get Data,” and drag down to “Create Data Source.” The create data source dialog box appears.

2. Field Names indicate the categories of information.

3. You choose your field names by simply removing the fields you do not want, and the remaining ones are the ones you maintain.

4. After selecting your field names, click “OK.”

5. The “Save” dialog box pops up in order to save the data document. Type a name for the file and click the “Save” button.

6. A dialog box appears, asking you whether you want to work in the data document or the main document.
7. Click the "Edit Data Source" button.
8. Enter the information in each field name. When you finish your first record, click "Add New" to start a new record. Once you are finished entering all the information, "Click OK."

9. Finalizing the Main Document
10. Type your main document (letter). When you need to insert a field name in your main document, make sure that the insertion point is located where you want the field to go. Click the "Insert Merge Field" button, and choose the appropriate "Field Name."

Merging and Printing Form Letters
1. Make sure you are in the main document.
2. Click the "Mail Merge Helper" button and the mail helper dialog box appears.
3. If the Main Document's Name doesn't show under the Create button Menu, refer back to starting the main document.
4. Click the "Merge" button, and the merge dialog box appears on the screen.
5. Go to "Merge To," and click on New Document and drag down to "Printer" (replace new document with printer.
6. Click on "Print."
Title: Technology Applications for the Exceptional Learner: Technology and Students with Special Learning Needs

Author(s): Dr. Janet Burke

Corporate Source: Western Connecticut State University

Publication Date: April 17, 1998

In order to disseminate as widely as possible timely and significant materials of interest to the educational community, documents announced in the monthly abstract journal of the ERIC system, Resources in Education (RIE), are usually made available to users in microfiche, reproduced paper copy, and electronic media, and sold through the ERIC Document Reproduction Service (EDRS). Credit is given to the source of each document, and, if reproduction release is granted, one of the following notices is affixed to the document.

I hereby grant to the Educational Resources Information Center (ERIC) nonexclusive permission to reproduce and disseminate this document as indicated above. Reproduction from the ERIC microfiche or electronic media by persons other than ERIC employees and its system contractors requires permission from the copyright holder. Exception is made for non-profit reproduction by libraries and other service agencies to satisfy information needs of educators in response to discrete inquiries.

Signed: Janet Burke

Printed Name/Position/Title: Janet Burke, Professor

Telephone: 203-837-8508

Fax: 

E-Mail Address: jac@wcsu.etsu.edu

Date: 8/23/98

Address: 181 White St.

Storrs, CT 06268-10
III. DOCUMENT AVAILABILITY INFORMATION (FROM NON-ERIC SOURCE):

If permission to reproduce is not granted to ERIC, or, if you wish ERIC to cite the availability of the document from another source, please provide the following information regarding the availability of the document. (ERIC will not announce a document unless it is publicly available, and a dependable source can be specified. Contributors should also be aware that ERIC selection criteria are significantly more stringent for documents that cannot be made available through EDRS.)

Publisher/Distributor:

Address:

Price:

IV. REFERRAL OF ERIC TO COPYRIGHT/REPRODUCTION RIGHTS HOLDER:

If the right to grant this reproduction release is held by someone other than the addressee, please provide the appropriate name and address:

Name:

Address:

V. WHERE TO SEND THIS FORM:

Send this form to the following ERIC Clearinghouse:

ERIC Clearinghouse on Educational Management
1787 Agate Street
5207 University of Oregon
Eugene, OR 97403-5207

However, if solicited by the ERIC Facility, or if making an unsolicited contribution to ERIC, return this form (and the document being contributed) to:

ERIC Processing and Reference Facility
1100 West Street, 2nd Floor
Laurel, Maryland 20707-3598

Telephone: 301-497-4080
Toll Free: 800-799-3742
FAX: 301-953-0263
e-mail: ericfac@inet.ed.gov
WWW: http://ericfac.piccard.csc.com

EFF-088 (Rev. 9/97)
PREVIOUS VERSIONS OF THIS FORM ARE OBSOLETE.